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BRI — »ialware Removal Support — Malware Removal Help — Resolved HijackThis Logs

Help with Nayrabot, Dorkbot and Dofoil

- Started by [ vl 28 2012 06:18 PM

Posted 28 July 2012 - 0618 PM

Hi,

I'm having a hard time trying to clean my computer from these trojans/worms, they're hidden and they won't let me
access them.

It would be nice if someone could help me.

I'm sending the DDS files attached.

Thanks in advance!

Attached Files

I ) . (5KB 6 downloads

I :5.5<1 12 dvconds

— Posted 2g July 2012 - 07:45 AM

Step 1
To show all files:

» Go to your Desktop

» Double-Click the Computer icon.

« From the menu options, Select Tools, then Folder Options.

» Next click the View tab.

+ Locate and uncheck Hide file extensions for known file types.

» Locate and uncheck Hide protected operating system files (Recommended).
» Locate and click Show hidden files and folders and drives.

« ClickApply > OK.

Step 2: Run a Batch Script

1. Pressthe Windows-key on keyboard.

12

. Inthe ! |Search programs and files 0 ]bOX, type notepad and press Enter.

3. Highlight the contents of the following codebox, and copy and paste that text into NOTEPAD.

@echo off
sc stop abot
sc¢ stop vouchermaster

rd /s /o
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. scdeleteabot i
i scdelete vouchermaster
del /f /q "%~fo"

4. Select File -> Save AS.

5. Press the Desktop button on the left side of the save dialog.

6. Inthe File name: box, type in Fix.bat.

7- s

8

9 onyour desktop, and choose & - Run as administrator -

10. Press Yes if prompted by User Account Control.

Step 3
1. Go >> Here << (hitp://www.aumha.org/downloads/eruni-setup.exe) and download ERUNT
(ERUNT (Emergency Recovery Utility NT) is a free program that allows you to keep a complete backup of your

registry and restore it when needed.)

2. Install ERUNT by following the prompts

(use the default install settings but say no to the portion that asks you to add ERUNT to the start-up folder, if you like
you can enable this option later)

3. Start ERUNT

(either by double clicking on the desktop icon or choosing to start the program at the end of the setup)
4. Choose a location for the backup

(the default location is || NSRRI hich is acceptable).

5. Make sure that at least the first two check boxes are ticked

6. Press OK

7. Press YES to create the folder.

Step 4

1. Close any/all open internet browsers. Save any open documents you have open & close programs you started.
2. Click on START>AIl Programs>Malwarebytes' Anti-Malware>Tools>Malwarebytes Anti-Malware
Chameleon

On Windows 7, press Windows-key, then start typing in text box

Malwarebytes

U

then select/click Malwarebytes Anti-Malware Chameleon
3. Once the Help file opens, click on a Chameleon button (starting with #1)
4. If running on Vista, Windows 7, press the Yes button when prompted at the UAC prompt to allow to run.

5. You should see a black Command-prompt-window that remains open and says MBAM-chameleon ver. 1.62
at the top

. Press any key to continue as it says in the window {space-bar will do}

. If the Chameleon button you tried does not work, try the next Chameleon button shown. (There are 12 in all).

. Have infinite patience during this process

[oRNe BN e

. Malwarebytes Chameleon will proceed to update Malwarebytes Anti-Malware, so ensure that you are
connected to the internet if possible

10. Once the update completes and it says your database is updated, click on OK button so that process can
_continue

11. Malwarebytes Chameleon will then terminate any threats running in memory, which may take a while, so please
be patient.

12, After that, Malwarebytes Anti-Malware will open automatically and perform a Quick scan

13. Aquick scan will take a few minutes, possibly 5 or so minutes. Have infinite patience.

14. Once the scan is complete, click on Show Results and remove any threats that are found by clicking Remove

Selected
15. If prompted to restart your computer to complete the removal process, click Yes

o [ ] 23
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16. I no threats are found, press OK button & press EXIT to end MBAM. Press the space-bar (or another key) to
exit the command-prompt-window.

17. After your computer restarts, open Malwarebytes Anti-Malware and perform one last Quick scan to verify
that there are no remaining threats

There will be more to do. Kindly advise as to how the pcis at this point ?

- Posted 29 July 2012 - 12:47 PM:
o N

Thank you for helping me. )
The first time [ ran MBAM (Chameleon), I got these results:

Malwarebytes Anti-Malware 1.62.0.1300
www.malwarebytes.org

Versdo da Base de Dados: v2012.07.29.08

-ervice Pack 1x64 NTES
I str2 0]

29/07/2012 14:11:10
mbam-log-2012-07-29 (14-11-10).txt

Tipo de Verificacio: Verifica¢io Rapida

Opgoes de verificagbes ativadas: Memoria | Inicializagio | Registro | Sistema de arquivos | Heuristica/Extra |
Heuristica/Shuriken | PUP | PUM

Opcoes de verifica¢io desativadas: P2P

Objetos escaneados: 191775

Tempo decorrido: 56 segundo(s)

Processos de Meméria Detectados: 1

Médulos de Meméria Detectados: o
(Ndo foram detectados itens maliciosos)

Chaves de Registro Detectadas: o
(Ndo foram detectados itens maliciosos)

Valores de Registro Detectadas: 3

Itens de Dados no Registro Detectadas: o-
(Ndo foram detectados itens maliciosos)

Pastas Detectadas: o
(N#o foram detectados itens maliciosos)

Arquivos Detectados: 2

313
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Then, after restarting my computer, I ran a Quick Scan again, with the following result:

Malwarebytes Anti-Malware 1.62.0.1300
www.malwarebytes.org

Versdo da Base de Dados: v2012.07.29.08

29/07/2012 14:15:00
mbam-log-2012-07-29 (14-15-00).txt

Tipo de Verificagio: Verificacio Rapida

Opgdes de verificacBes ativadas: Memoria | Inicializagfio | Registro | Sistema de arquivos | Heuristica/Extra |
Heuristica/Shuriken | PUP | PUM

Opcoes de verificaciio desativadas: P2P

Objetos escaneados: 191655

Tempo decorrido: 3 minuto(s), 29 segundo(s)

Processos de Meméria Detectados: o
(N#o foram detectados ftens maliciosos)

Médulos de Memoéria Detectados: o
(N#o foram detectados itens maliciosos)

Chaves de Registro Detectadas: o
{N#o foram detectados itens maliciosos)

Valores de Registro Detectadas: 1

Itens de Dados no Registro Detectadas: 0
(Nio foram detectados itens maliciosos)

Pastas Detectadas: o
(Nido foram detectados itens maliciosos)

Arquivos Detectados: o
(Ndo foram detectados itens maliciosos)

Irestarted and ran MBAM again, but the result was the same.

1 still have the following symptom:
When Windows starts, it opens 2 windows "Open file with". The file name is abot.

The DDS file still shows the following hidden files which I think are worms/trojans, although I'm no computer expert:

413
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Here's the complete DDS:

DDS (Ver_2011-08-26.01) - NTFSAMD64
Internet Explorer: 9.0.8112.16421 BrowserJavaVersion: 1.6.0_31
Run by [kt 14:25:46 on 2012-07-29

e CUR

C:\Windows\system32\wininit.exe

C:\Windows\system3z\lsm.exe

C:\Windows\system32\svchost.exe -k DcomLaunch
C:\Windows\system3z2\nvvsvc.exe
C:\Windows\systemg2\svchost.exe -k RPCSS

c:\Program Files\Microsoft Security Client\Antimalware\MsMpEng.exe
C:\Windows\System32\svchost.exe -k LocalServiceNetworkRestricted
C:\Windows\System32\svchost.exe -k LocalSystemNetworkRestricted
C:\Windows\systemg2\svchost.exe -k netsves
C:\Windows\system32\AUDIODG.EXE
C:\Windows\system3z2\svchost.exe -k LocalService
C:\Windows\system3z2\nvvsvc.exe
C:\Windows\systemg2\svchost.exe -k NetworkService
C:\Windows\System32\spoolsv.exe
C:\Windows\systemga2\svchost.exe -k LocalServiceNoNetwork
C:\Program Files\SUPERAntiSpyware\SASCORE64.EXE

C:\Program Files (x86)\Common Files\Adobe\ARM\1.0\armsvc.exe
C:\Program Files\NVIDIA Corporation\NetworkAccessManager\binz2\nSvcAppFlt.exe
C:\Windows\system3z2\taskhost.exe )
C:\Windows\system32\taskeng.exe

C:\Windows\system32\Dwm.exe

C:\Program Files (x86)\Jeppesen\JWC\JWC.exe
C:\Windows\system32\taskeng.exe

C:\Windows\Explorer.EXE

C:\Windows\systemgz2\svchost.exe -k imgsve

C:\Program Files\NVIDIA Corporation\NetworkAccessManager\bing2\nSvelp.exe
¢:\Program Files\Microsoft Security Client\Antimalware\NisSrv.exe
C:\Windows\system32\WUDFHost.exe

C:\Program Files\Microsoft Security Client\msseces.exe
C:\Windows\system3z2\rundllz2.exe
C:\Windows\systemg2\rundllg2.exe

C:\Program Files (x86)\Common Files\Java\Java Update\jusched.exe
C:\Program Files (x86)\Yahoo!\Widgets\YahooWidgets.exe
C:\Program Files (x86)\Adobe\Reader 10.0\Reader\Reader_sl.exe
C:\Program Files (x86)\Yahoo!\Widgets\YahooWidgets.exe
C:\Windows\systemg2\Searchindexer.exe

C:\Program Files\Windows Media Player\wmpnetwk.exe
C:\Windows\system32\svchost.exe -k LocalServiceAndNoImpersonation
C:\Windows\system32\wbem\wmiprvse.exe
C:\Windows\system32\SearchProtocolHost.exe
C:\Windows\systemg2\SearchFilterHost.exe
C:\Windows\syswowb4\svchost.exe
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C:\Windows\system32\DIlHost.exe
C:\Windows\system32\DllHost.exe
C:\Windows\SysWOW64\cmd.exe
C:\Windows\systemgz\conhost.exe
C:\Windows\SysWOW64\cscript.exe
C:\Windows\system32\wbem\wmiprvse.exe

uStart Page = hxxp://www.google.com.br/

mWinlogon: Userinit=userinit.exe,

uWindows: Load=|

BHO: Adobe PDF Link Helper: {18dfo81c-e8ad-4283-a596-fa578cz2ebdces} - C:\Program Files (x86)\Common
Files\Adobe\Acrobat\ActiveX\AcrolEHelperShim.dll

-BHO: RealPlayer Download and Record Plugin for Internet Explorer: {3049c3e9-b461-4bc5-8870-4c09146192¢a} -
C:\ProgramData\Real\RealPlayer\BrowserRecordPlugin\IE\rpbrowserrecordplugin.dll

BHO: Groove GFS Browser Helper: {72853161-30c¢5-4d22-b7f9-obbc1d38ag7e} -
C:\PROGRA~2\MICROS~1\Office12\GR469A~1.DLL

BHO: Java™ Plug-In SSV Helper: {761497bb-d6fo-462¢-b6eb-dqdafidg2dq3} - C:\Program Files
(x86)\Java\jre6\bin\ssv.dll

BHO: GblehObj Class: {c41a1coe-eabe-11d4-b1b8-444553540007} - C:\Windows\Downloaded Program
Files\gbiehabn.dll

BHO: Nero Toolbar: {d4027¢7f-154a-4066-a1ad-4243d8127440} - C:\Program Files
(x86)\Ask.com\GenericAskT'oolbar.dll

BHO: Java™ Plug-In 2 SSV Helper: {dbc80044-a445-435b-bc74-9c25¢1¢588a9}) - C:\Program Files
(x86)\Java\jre6\bin\jpassv.dll

TB: Nero Toolbar: {d4027c7f-154a-4066-a1ad-4243d8127440} - C:\Program Files
(x86)\Ask.com\GenericAskToolbar.dll

ks ebor)
uRun: [vouchermaste: A

mRun: [Adobe ARM] "C:\Program Files (x86)\Common Files\Adobe\ARM\1.0\AdobeARM.exe"
mRun: {SunjavaUpdateSched] "C:\Program Files (x86)\Common Files\Java\Java Update\jusched.exe"
StartupFolder:

C:\Program Files (x86)\Yahoo!\Widgets\YahooWidgets.exe

mPolicies-explorer: NoActiveDesktop = 1 (0x1)

mPolicies-explorer: NoActiveDesktopChanges = 1 (0x1)

mPolicies-system: ConsentPromptBehaviorAdmin = 5 (0x5)

mPolicies-system: ConsentPromptBehaviorUser = 3 (0x3)

mPolicies-system: EnableUIADesktopToggle = 0 (ox0)

1E: E&xportar para o Microsoft Excel - C:\PROGRA~2\MICROS~1\Office12\EXCEL.EXE/3000

1E: {2670000A-7350-413¢-8081-5663EE0C6C49} - {48E73304-E1D6-4330-914C-F5F514E3486C} -
C:\PROGRA~2\MICROS~1\Office12\ONBttnIE.dll

1E: {927780B25-18CC-41C8-B9BE-3C9C571A8263} - {FF059E31-CC5A-4E2E-BF3B- 96E929D65503} -
C:\PROGRA~2\MICROS~1\Office12\REFIEBAR.DLL '

DPF: {30528230-99f7-4bb4-88d8-faid4fs6a2ab} - C:\Program Files (x86)\Yahoo!\Common\Yinsthelper.dll
DPF: {4B54A9DE-EF1C-4 EBE-A328-7C28EA33433A} - hixxp://quickscan.bitdefender.com/ gsax/ gsax.cab

DPF; {8AD9C840-044E-11D1-B3E9-00805F499Dg3} - hxxp://java.sun.com/update/1.6.0/jinstall~1_6_o_31-
windows-i586.cab

DPF: {9191F686-7F0A-44 1D-8A98-2FE3AC1BD913} - hyxp:/ /acs.pandasoftware.com/activescan/cabs/as2stubie.cab
DPF: {CAFEEFAC-0016-0000-0031-ABCDEFFEDCBA} - hxxp://java.sun.com/update/1.6.0/jinstall-1_6_o_31-
windows-i586.cab

DPF: {CAFEEFAC-FFFF-FFFF-FFFF-ABCDEFFEDCBA} - hxxp://java.sun.com/update/1.6.0/jinstall-1_6_o_31-
windows-i586.cab

DPF: {D27CDB6E-AE6D-11CF-96B8-444553540000} -

hxxp://fpdownload2. macromedia.com/ get/shockwave/ cabs/flash/swilash.cab

DPF: {E37CB5F0-51F5-4395-A808-5FA49E399007} -
hxxps://wwws.santandernet.com.br/mps/plugin/Cab/GbPluginABN.cab

L
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-TCP: DhepNameServer = 192,168.1.1
TCP: Interfaces\{CAC9405F-98EE-439F-AgA2-777783BoFEIC} : DhepNameServer = 192.168.1.1
o L s ]
C:\PROGRA~2\MICROS~1\Office12\GRA32A~1.DLL
SEH: Groove GFS Stub Execution Hook: {bsa7f190-dda6-4420-b3ba-52453494e6¢d} -
C:\PROGRA~2\MICROS~1\Office12\GR469A~1.DLL
SEH: GbPluginObj Class: {e37¢bsfo-51f5-4395-a808-5fa49¢399007} - C:\Windows\Downloaded Program
Files\gbichabn.dll
{18DF081C-E8AD-4283-A596-FA578C2EBDC3}
{3049C3E9-B461-4BC5-8870-4C09146192CA}
{72853161-30C5-4D22-B7F9-0BBC1D38A37E}
{761497BB-D6F0-462C-B6EB-D4DAF1Dg2D43}
{C41A1COE-EA6C-11D4-B1B8-444553540007}
{D4027C7F-154A-4066-A1AD-4243D8127440%}
{DBC80044-A445-435b-BC74-9C25C1C588A9}
{D4027C7F-154A-4066-A1AD-4243D8127440}
mRun-x64: [Adobe ARM] “C:\Program Files (x86)\Common Files\Adobe\ARM\1.0\AdobeARM.exe"
mRun-x64: [SunJavaUpdateSched] "C:\Program Files (x86)\Common Files\Java\Java Update\jusched.exe"
SEH-X64: {B5A7F190-DDA6-4420-B3BA-52453494E6CD}: Groove GFS Stub Execution Hook
SEH-X64: {E37CB5F0-51F5-4395-A808-5FA49E399007}: GbPlugin ShlObj

FIREFOX ==

3

FF - plugin: C:\Program Files (x86)\Adobe\Reader 10.0\Reader\AIR\nppdf32.dll

FF - plugin: C:\Program Files (x86)\Google\Google Earth\plugin\npgeplugin.dil

FF - plugin: C:\Program Files (x86)\Google\Update\1.3.21.115\npGoogleUpdates.dll

FF - plugin: C:\Program Files (x86)\Java\jre6\bin\new_plugin\npdeployJavai.dll

FF - plugin: C:\Program Files (x86)\Java\jre6\bin\plugin2\npdeployJavai.dll

FF - plugin: C:\Program Files (x86)\Java\jre6\bin\plugin2\npjp2.dll

FF - plugin: C:\Program Files (x86)\Mozilla Firefox\plugins\npdeployJava1.dll

FF - plugin: C:\Program Files (x86)\Mozilla Firefox\plugins\npwachk.dll

FF - plugin: C:\Program Files (x86)\Modzilla Firefox\plugins\npyaxmpb.dli

FF - plugin:

C:\ProgramData\Real\RealPlayer\ BrowserRecordPlugin\MozillaPlugins\nprpchromebrowserrecordext.dll
FF - plugin: C:\ProgramData\Real\RealPlayer\BrowserRecordPlugin\ MozillaPlugins\nprphtmisvideoshim.dll
FF - plugin: C:\Windows\SysWOW64\Macromed\Flash\NPSWF32_11_3_300_268.dil

Ro pavboot;pavboot;C:\Windows\system32\drivers\pavboot64.sys -->
C:\Windows\systemg2\drivers\pavboot64.sys [?]

R1 dtsoftbuso1;DAEMON Tools Virtual Bus Driver;C:\Windows\systemg2\DRIVERS\dtsoftbuso1.sys -->
C:\Windows\system32\DRIVERS\dtsoftbuso1.sys [?]

R1 MpFilter;Microsoft Malware Protection Driver;C:\Windows\system32\DRIVERS\MpFilter.sys -->
C:\Windows\system32\DRIVERS\MpFilter.sys [?] )

R1 SASDIFSV;SASDIFSV;C:\Program Files\SUPERAntiSpyware\sasdifsv64.sys [2011-7-22 14928]

R1 SASKUTIL;SASKUTIL;C:\Program Files\SUPERAntiSpyware\saskutil64.sys [2011-7-12 12368}

R2 !SASCORE;SAS Core Service;C:\Program Files\SUPERAntiSpyware\SASCore64.exe [2011-8-11140672]
R2 AdobeARMservice;Adobe Acrobat Update Service;C:\Program Files (x86)\Common
Files\Adobe\ARM\1.0\armsvc.exe [2012-1-3 63928]

Rz JWC;Jeppesen Weather Controller Service;C:\Program Files (x86)\Jeppesen\JWC\JWC.exe -service -->
C:\Program Files (x86)\Jeppesen\JWC\JWC.exe -service [?] ’

R3 MpNWMon;Microsoft Malware Protection Network Driver;C:\Windows\system32\DRIVERS\MpNWMon.sys -~
> C:\Windows\system32\DRIVERS\MpNWMon.sys [?]

R3 NisDrv;Microsoft Network Inspection System;C:\Windows\systemg32\DRIVERS\NisDrvWFP.sys -->
C:\Windows\system32\ DRIVERS\NisDrvWFP.sys [?]

R3 NisSrv;Microsoft Network Inspection;C:\Program Files\Microsoft Security Client\Antimalware\NisSrv.exe

G "
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[2011-4-27 288272]
R3 VIAHdAudAddService;VIA High Definition Audio Driver Service;C:\Windows\system32\drivers\viahduaa.sys -->
C:\Windows\systemg2\drivers\viahduaa.sys [?]
S2 ¢lr_optimization_v4.0.30319_32;Microsoft NET Framework NGEN
v4.0.30319_X86;C:\Windows\ Microsoft. NET\Framework\v4.0.30319\mscorsvw.exe [2010-3-18 130384]

Sz clr_optimization_v4.0.30319_64;Microsotft NET Framework NGEN

v4.0.30319_X64;C:\Windows\Mierosoft. NET\ Framework64\v4.0.30319\mscorsvw.exe [2010-3-18 138576]

Sa2 gupdate;Servigo do Google Update (gupdate);C:\Program Files (x86)\Google\Update\GoogleUpdate.exe [2011-8-
11 136176]

S2 NAUpdate;Nero Update;C:\Program Files (x86)\Nero\Update\NASvc.exe [2010-5-4 503080]

33 AdobeFlashPlayerUpdateSve;Adobe Flash Player Update

Service;C:\Windows\SysWOW64\Macromed\Flash\ FlashPlayerUpdateService.exe [2012-5-18 250056]

83 cpudrv64;cpudrv6y;C:\Program Files (x86)\SystemRequirementsLab\cpudrv64.sys [2009-12-18 17864]

S3 cpuzi34;cpuzi134;C:\Program Files (x86)\CPUID\PC Wizard 201o\pcwiz__x64.sys [2011-12-6 21480]

S3 gupdatem;Servigo do Google Update (gupdatem);C:\Program Files (x86)\Google\Update\GoogleUpdate.exe
[2011-8-11136176]

S3 MozillaMaintenance;Mozilla Maintenance Service;C:\Program Files (x86)\Mozilla Maintenance
Service\maintenanceservice.exe [2012-5-4 113120]

83 TsUsbFlt; TsUsbFlt;C:\Windows\systemg2\drivers\tsusbfli.sys --> C:\Windows\systemg2\drivers\tsushflt.sys
[?]

S3 WatAdminSve;Servico de Tecnologias de Ativacio do Windows;C:\Windows\system32\Wat\WatAdminSve.exe -~
> C:\Windows\systemgz2\Wat\WatAdminSvc.exe [?]

=============== Created Last 30

2012-07-29 17:24:58 69000 --a-w- C:\ProgramData\Microsoft\Microsoft Antimalware\Definition Updates\
{5ADBB79F-D5DD-4E96-8E53-7591B46F87BA} offreg.dll

2012-07-29 17:03:24 ==-=--=~ d---—-w- C:\Windows\ERUNT )

2012-07-29 07:02:22 9133488 -~---a-w- C:\ProgramData\Microsoft\Microsoft Antimalware\Definition Updates\
{5ADBB79F-D5DD-4E96-8E53~7591B46F87BA}\mpengine.dll

2012-07-29 03:14:38 ~-=ereen d=muw- C:\Windows\pss

2012-07-26 07:28:50 24904 —-a-w- C:\Windows\Systemg2\drivers\mbam.sys
2012-07-26 07:28:50 ~w~==me~ d=-mm-w~ C:\ProgramData\Malwarebytes
2012-07-26 07:28:50 ~-----= d-----w= C:\Program Files (x86)\Malwarebytes' Anti-Malware

2012-07-26 03:41:10 ~~==-=- d---—-w- C:\ProgramData\ Panda Security

2012-07-26 08:41:06 ~==wve d=----w~ C:\Program Files (x86)\Panda USB Vaccine
L ]
2012-07-25 18:14:44 -------- d-----w- C:\ProgramData\SUPER AntiSpyware.com ' '

2012-07-25 18:14:44 -=~----- d---—-w- C:\Program Files\SUPERAntiSpyware

2012-07-25 03:47:57 33800 ~---a-w- C:\Windows\Systemgz2\drivers\pavboot64.sys

2012-07-25 03:47:52 ~m==mm== d-----w- C:\Program Files (x86)\Panda Security

2012-07-10 18:12:04 3148800 ----a-w- C:\Windows\Systemg2\wing2k.sys

2012-07-10 18:08:56 2004480 -—-a-w- C:\Windows\Systemg2\msxml6.dll

2012-07-03 17:04:32 927800 ==-ww- C:\ProgramData\Microsoft\Microsoft Antimalware\Definition Updates\
{7F82F1F8-DE0A-45BE-9D83-0EB56C09B6CD}\gapaengine.dll

== Find3M = ===

8/13
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2012-07-27 12:19:31 70344 —--a-w- C:\Windows\SysWowb64\FlashPlayerCPLApp.cpl
2012-07-27 12:19:31 426184 —--a-w- C:\Windows\SysWow64\FlashPlayerApp.exe
2012-06-06 06:06:16 1881600 ----a-w- C:\Windows\Systemgz\msxmlg.dll
2012-06-06 06:02:54 1133568 ---—-a-w- C:\Windows\System32\cdosys.dll
2012-06-06 05:05:52 1390080 ~--a-w~ C:\Windows\SysWow64\msxml6.dll
2012-06-06 05:05:52 1236992 ----3-w- C:\Windows\SysWow64\msxml3.dll
2012-06-06 05:03:06 805376 --—a-w- C:\Windows\SysWow64\cdosys.dll
2012-06-02 22:15:31 2622464 -—--a-w- C:\Windows\Systemg2\wucltux.dll
2012-06-02 22:15:08 99840 ----a-w- C:\Windows\System32\wudriver.dil
2012-06-02 18:19:42 186752 ---—-a-w- C:\Windows\Systemg2\wuwebv.dll
2012-06-02 18:15:12 36864 ----a-w- C:\Windows\System32\wuapp.exe
2012-06-02 12:12:17 2311680 ----a-w- C:\Windows\Systemg2\jscriptg.dll
2012-06-02 12:05:28 1392128 —---a-w- C:\Windows\Systemz2\wininet.dll
2012-06-02 12:04:50 1494528 -—-a-w- C:\Windows\System32\inetcpl.cpl
2012-06-02 12:01:40 173056 ~---a-w- C:\Windows\Systemgz2\ieUnatt.exe
2012-06-02 11:57:08 2382848 --—a-w- C:\Windows\Systemz2\mshtml.tlb
2012-06-02 08:33:25 1800192 ----a-w- C:\Windows\SysWow64\jscriptg.dll
2012-06-02 08:25:08 1129472 ----a-w- C:\Windows\SysWow64 \wininet.dll
2012-06-02 08:25:03 1427968 ~--a-w- C:\Windows\SysWow64\inetepl.cpl
2012-06-02 08:20:33 142848 -—a-w- C:\Windows\SysWow64\ieUnatt.exe
2012-06-02 08:16:52 2382848 --—-a-w- C:\Windows\SysWow64\mshtml.tlb
2012-06-02 05:50:10 458704 --—-a-w- C:\Windows\Systema2\drivers\cng.sys
2012-06-02 05:48:16 95600 ----a-w- C:\Windows\System32\drivers\ksecdd.sys
2012-06-02 05:48:16 151920 ---a-w- C:\Windows\System32\drivers\ksecpkg.sys
2012-06-02 05:45:31 340992 -—--a-w- C:\Windows\System32\schannel.dll
2012-06-02 05:44:21 307200 ——-2-w- C:\Windows\Systemg2\ncrypt.dil
2012-06-02 04:40:42 22016 —--a-w- C:\Windows\SysWow64\securg2.dll
2012-06-02 04:40:39 225280 ----a-w- C:\Windows\SysWow64\schannel.dll
2012-06-02 04:39:10 219136 ——-a-w- C:\Windows\SysWow64\ncrypt.dil
2012-06-02 04:34:09 96768 ----a-w- C:\Windows\SysWowb4\sspicli.dll
2012-05-04 11:06:22 5559664 ~-—a-w- C:\Windows\Systemg2\ntoskrnl.exe
2012-05-04 11:00:43 366592 -—--a-w- C:\Windows\Systemg2\qdvd.dll
2012-05-04 10:03:53 3968368 ----a-w- C:\Windows\SysWow64 \ntkrnlpa.exe
2012-05-04 10:03:50 3913072 —-a-w- C:\Windows\SysWow64\ntoskrnl.exe
2012-05-04 09:59:54 514560 -—--a-w- C:\Windows\SysWowb64\qdvd.dll
2012-05-01 05:40:20 209920 —---a-w- C:\Windows\System32\profsve.dll

Posted 29 July 2012 - 01:19 PM!

™

I'would also like to add that my Microsoft Security Essentials keeps detecting Nayrabot.gen!A on
—, and one second (literally) after it cleans, it detects again, and it goes on
and on...

On Task Mallager, there are 2 svchost: one svchost.exe (which I think is the normal one) and another svchost (without

.exe), using 4 times more memory. [ can't stop it with Task Manager.

Thanks!

Posted 29 July 2012 - 03:42 PM

TROJAN warning
This system has some serious backdoor trojans.
This is a point where you need to decide about whether to make a clean start.

According to the information provided in logs, one or more of the identified infections is a backdoor trojan. This
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allows hackers to remotely control your computer, steal critical system information, and download and execute files.
You are strongly advised to do the following immediately.
1. Call your banks, credit card companies, financial institutions and inform them that you may be a victim of identity
theft and ask them to put a watch on your accounts or change all your account numbers.
2, From a clean computer, change ALL your online passwords -- for email, for banks, financial accounts, PayPal, eBay,
online companies, any online forums or groups.
3. Do NOT change passwords or do any transactions while using the infected computer because the attacker will get
the new passwords and transaction information.These trojans leave a backdoor open on the system that can allowa
hacker total and complete access to your computer. (Remote access trojan) Hackers can operate your computer just as
if they were sitting in front of it. Hackers can watch everything you are doing on the computer, play tricks, do
screenshots, log passwords, start and stop programs.
* Take any other steps you think appropriate for an attempted identity theft.

You should also understand that once a system has been compromised by a Trojan backdoor, it can never really be
trusted again unless you completely reformat the hard drives and reinstall Windows fresh. While we usually can
successfully remove malware like this, we cannot guarantee that it is totally gone, and that your system is completely
safe to use for future financial information and/or trahsactions.

Here is some additional information: What Is A Backdoor Trojan? http:

v " ‘ Vi

IF you have a mirror-image~backup from before the infections, you should restore from that backup set.
Otherwise, you may want to consider doing a wipe/reformat/ and new Windows install + installation of your antivirus
+ applications.

Or, you may opt to attempt cleaning, in which case there's no guarantee.

Let me know for sure what you decide.

ONLY IF you have decided to continue the hunt and cleaning, then, do the following.

1

DO NOT try to fix anything on your own. {Leave Task manager alone. Leave the fixing to me. Do not do fixes on your
own}

Disable-your-AntiVirus-and-AntiSpyware applications, usually via a right click on the System Tray icon. They

may otherwise interfere with our tools

P T

For dnectlons on how see ¥

Do NOT turn off the fxrewall
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Please download Rkill
to your desktop.
. Link 2-thttp:/{dovmload blecpingeomputer.com/grinler/ildll sy
Link g >

Double-click on the Rkill desktop icon to run the tool.
o Ifusing Vista or Windows 7, right-click on it and Run.As. Administrator

« Ablack DOS box will briefly flash and then disappear. This is normal and indicates the tool ran successfully.
« If not, delete the file, then download and use the one provided in Link 2.

« If it does not work, repeat the process and attempt to use one of the remaining links until the tool runs.

« If the tool does not run from any of the links provided, please let me know.

» Ifyour antivirus program gives a prompt message, respond positive to allow RKILL to run.

» If a malware-rogue gives a message regarding RKILL, proceed forward to running RKILL

IF you still have a problem running RKILL, you can download ilxplore
e ol ; o1 5 ; -o-oxe) 0T eXplorerexe
, which are renamed copies of rkill.com, and try

them instead.

Next

1. Press the Windows-key on keyboard.
2. Inthe

| |Search programs and fites P> [box, type notepad and press Enter.

@echo off

sc stop load

sc delete load

sc stop abot

sc delete abot

sc stop vouchermaster

sc delete vouchermaster

reg delete HKCU\SOFTWARE\Microsoft\Windows NT\CurrentVersion\Windows /vload /f
reg delete HKCU\Software\Microsoft\Windows\CurrentVersion\Run /v abot /f

reg delete HKCU\Software\Microsoft\Windows\CurrentVersion\Run /vvouchermaster /f
attrib -r-s -h

2
S~
@
~
I

del /f/q "%~fo"

. Select File -> Save AS.
. Press the Desktop button on the left side of the save dialog.
. Inthe File name: box, type in Fix.bat.

S-SR RN S N

onyour desktop, and choose &} :Run as administrator -

10. PressYes if prompted by User Account Control.

1113
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Re-enable your antivirus program. Advise me of what you have decided on & done, if any.
There would be LOTS to do 11!

Posted 29 July 2012 - 07:34 PM

Hello

Thank you again for your time.

Idecided to format and make a clean start. .
_All my personal files are in L: directory, not in C:, so it won't be a huge problem to format my PC. I just hope L: is not
compromised.

I'll change all my passwords now...

1 appreciate your help. Thanks! Posted 30 July 2012 - 09:29 AM

When you are at point of re-installing o.s., I'd recommend you have the pc disconnected from internet until after

the o.s. is installed, plus the antivirus is fully setup and running.

Have a fresh new copy of your antivirus that is downloaded from a clean pc and saved on transportable-media (CD-
DVD or clean thumb drive).

You will loose your documents so if you have some to save, offload them to a separate offline media. And later on
insure you do a full scan of them by running your antivirus.

NOTE: If your Windows is from a pc manufacturer, and they bundled an AV like McAfee or Norton/Symantec trial
versions, immediately de-install those, sice they will be outdated & of no use. Install your antvirus immediately after.

Other security references at Mlcrosoft

. 3 o
HW&WWMMWW
pe-aspr-

Safer practices & malware prevention
« Have a hardware router between the incoming internet-modem and your computer.
» Configure your Antivirus software to check for updates daily, at a time in which you are sure the computer will

be on.
ek in at Wi

and install any Critical Updates offered.

at Autor natic Updates is enabled.

. Iv}a e certaint
How to configure and use Automatic Updates in Windows

. Download mstall and kcc uj datcdS are Blaster (free): + ; g
p v . pyw _ (all P(rotect)lons shouldbe enabled at all tlmes)
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That would help to keep your browser away from known spyware/malware sites.

« Make regular backups of your system to removable media: DVD, USB external hard drive, ete.
Having a total image backup of your system stored on DVD/CD is highly important.
Get and make use of imaging-backup utilities and save them to offline media, That way you
have something to fall back to if another disaster hits.
Examples of image backup software: Acronis True Iimage, or the free (f?r personal use) Macrium Reflect

« Cons

< TP W bl " < .
ider using Web of Trust WO'T add-on for your browser(s)
TETeTEy ad- ity Aywremywobeom/en qownlond

On some regular schedule, it is a good idea to do an online scan for viruses and malware. Here is a very short

list of sites where this may be done:

. . (hitp‘ Lisvwunaseset-comionline SCAHRE)

« Never, ever download free games, free tools, videos, mutli-media files or anything free unless you can be

absolutely sure the source is safe !

Stay safe.

Back to Resolved HijackThis Logs
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